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m _macromiiia CAPITULO |
ISH INTRODUCAO

bt dtee

Os filmes do Flash s&o imagens e animagOes para sites da Web. Eles
consistem principalmente em imagens vetoriais, mas também podem conter sons e
imagens de bitmap importadas. Os filmes do Flash podem incorporar interatividade
para permitir a entrada de dados pelo publico e criar filmes ndo-lineares que podem
interagir com outros aplicativos da Web. Os designers da Web utilizam o Flash para
criar controles de navegagdo, logotipos animados, longas animagdes com som
sincronizado e até sites da Web mais completos do ponto de vista sensorial. Os
filmes do Flash sédo imagens vetoriais compactas; portanto, o seu download é rapido
e eles sdo dimensionados para o tamanho da tela do visualizador. Provavelmente,
vocé ja assistiu e interagiu com filmes do Flash em varios sites da Web, incluindo
Disney ® , Os Simpsons ® e Coca-Cola ® . Milhdes de usuéarios da Web receberam
o Flash Player com seus computadores, navegadores ou software de sistema; outros
fizeram o download a partir do site da Macromedia na Web. O Flash Player reside no
computador local, onde reproduz filmes em navegadores ou como aplicativos
independentes. Exibir um filme do Flash no Flash Player é semelhante a exibir uma
fita de video em um VCR ou DVD — o Flash Player é o dispositivo usado para exibir
os filmes criados no aplicativo de criagédo Flash.

1.1 - REQUISITOS DO SISTEMA

= Para o Microsoft Windows™: processador Intel Pentium ® 133 MHz ou
equivalente (recomenda-se 200) executando o Windows 95 ou superior (incluindo
o Windows 2000), ou NT verséo 4.0 ou posterior; 32 MB de RAM (recomenda-se
64 MB); 40 MB de espaco disponivel em disco, monitor colorido com capacidade
de resolugéo de 800 x 600.

= Para o Macintosh ® : Power Macintosh (recomenda-se G3 ou posterior)
executando o System 8.5 ou posterior; memoria de aplicativo livre de 32 MB RAM
mais 40 MB de espaco disponivel em disco, monitor colorido com capacidade de
resolucéo de 800 x 600 e unidade de CD-ROM.
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2.1 - BARRA DE MENUS

@J_Eile Edit “iew Insert Modify Test Control ‘wWindow Help

No alto da tela, logo abaixo da barra de titulos, encontra-se a barra de menus.
Veja em seguida a finalidade de cada menu:

File - Nesse menu encontram-se todos os comandos de exportacdo e importacao de
arquivos, além dos comandos de gravacdo de projetos, criagdo de arquivos de
filmes, GIFs animadas, AVI, etc. Também neste menu encontram-se diversos
comandos que permitem a alteracdo das configuracdes genéricas do ambiente de
desenvolvimento, e as definicdes de impressao.
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Edit - Esse menu apresenta as op¢des genéricas de edi¢do, a maioria com botdes
correspondentes, tais como: copiar e colar, editar simbolos, ligacdes, etc.

View - Esse menu permite modificar a aparéncia e o funcionamento da area de
trabalho e seus elementos.

Insert - Apresenta diversos comandos de insercdo de elementos de controle do
filme.

Modify - Esse menu contém diversas op¢cBes de modificacdo de elementos de
desenho e parametros que afetam o comportamento de todo projeto.

Text - Apresenta comandos para edicdo de texto, tais como: tamanho e tipo de
fonte, alinhamento, cor e etc.

Windows - Além de controlar a forma de apresentacdo das janelas de diversos
projetos — em cascata, lado a lado, etc. — esse menu oferece ainda a possibilidade
de ocultar ou apresentar as diversas barras de ferramentas do Flash.

Help - O menu de auxilio do Flash é bastante rico em informacdes, e traz inclusive
um tour pelo programa (em inglés) e um link para o centro de desenvolvedores Flash

na Web. Ha ainda a opcado Samples, com diversos exemplos de técnicas interativas,
prontas para usar, editar ou estudar.

2.2 - BARRA DE FERRAMENTAS PADRAO
D HOR » 28 o« (A S0 7k

Logo abaixo da barra de menus, encontra-se a barra de ferramentas padrao.
Vamos ver rapidamente a fungéo de cada botao:

_] New - Pressione esse botdo para iniciar um novo projeto.

~d

Open - Esse botdo permite a abertura de projetos do Flash, de outros
aplicativos compativeis mais antigos (como Future Splash, que deu origem ao Flash)
ou até mesmo filmes do Flash ja em formato SWF.

Save: Grava em disco as Ultimas alteracdes do projeto. Se o projeto estiver
sendo gravado pela primeira vez, vocé devera dar um nome ao arquivo e escolher
um diretdrio para armazena-lo.
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Print: Imprime a tela atual do projeto.

=" Cut: Apaga o objeto selecionado e copia-no na Area de Transferéncia.

g

Copy: Copia 0 objeto selecionado e leva-o para a Area de Transferéncia.

Paste: Insere o contetido da Area de Transferéncia.

5

. Undo: Desfaz o Ultimo comando.

Redo: Refaz o Ultimo comando desfeito com o Undo.

" Snap: Liga/desliga o recurso de ajuste a grade e a conexao de linhas.

=5
4

I:::I . Rotate: Torna visiveis as “alcas” de rotagdo em torno do objeto selecionado,
permitindo diversas distor¢des no desenho.

I:::I . Scale: Torna visiveis as “algas” de ajuste de tamanho em torno do objeto
selecionado, permitindo sua reducdo ou ampliacéo.

. Smooth: Suaviza ou “arredonda” a linha selecionada.

. Straighten: Corrige a linha selecionada, tornando-a mais reta.

O+

|b— Align: Apresenta uma caixa de dialogo na qual é possivel alinhar os objetos
selecionados, tanto vertical como horizontalmente, permitindo ainda o ajuste
opcional das dimensfGes dos objetos dos objetos, para que figuem iguais em
tamanho e alinhamento.
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2.3 - BARRA DE FERRAMENTAS DE CRIACAO GRAFICA

oeta — Subselecionar
Linha ——~ Laco
Caneta ——§ A Taxto
Crval —— [ Retangulo
Lapis —F2¢ & Pincel
Manouim — 48 Balde de Tinta
Conta-gotas s Bomacha
hao — Zoom

Cor do trago

Cor do preanchimeanto

Medificadores —
de ferramentas

Localizada no canto esquerdo da tela, essa barra de ferramentas de criagéo e
edicdo de desenhos, pintura e texto. Os botdes dessa barra podem ser acessados
com cligues do mouse, ou pressionando as teclas correspondentes no teclado.
Alguns desses bhotbes trabalham em conjunto com ferramentas modificadoras, que
alteram o comportamento da ferramenta. Os Painéis de Configuragdo, que serédo
estudados no proximo capitulo, também agem diretamente sobre essas ferramentas.
Veja em seguida a descricdo de cada ferramenta, com seus modificadores, entre
colchetes a tecla de atalho.

h': Seta [V] - A seta é usada para selecionar, arrastar e transformar elementos
graficos e de texto.

h} Subselecionar [A] - Marca diversas “alcas” ao redor do objeto selecionado,
possibilitando diversas deformagfes no mesmo.

a Centro de Informética — Secdo de Projetos Cientificos
Apostila de Flash 5 Basico www.ufpel.tche.br/ci/spc



UNIVERSIDADE FEDERAL DE PELOTAS

=

. Linha [N] - Traca somente linhas perfeitamente retas.

Laco [L] - A ferramenta de laco permite selecionar areas com formatos
irregulares. Com a ferramenta de seta somente é possivel selecionar areas
retangulares ou quadradas. Com esta ferramenta, qualquer formato pode ser

conseguido. Possui trés botdes modificadores:

. Magic Wand e = Magic Wand Properties - Servem para o
tratamento de imagens criadas a partir de bitmaps importados.

. i Polygon Mode - Seleciona areas com linhas retas.

ﬁ . Caneta [P] - Desenhar caminhos precisos como linhas retas ou curvas
suaves. Vocé pode criar segmentos de linha curvos ou retos e ajustar o angulo e o
comprimento de segmentos retos além da inclinacdo de segmentos curvos.

» Para desenhar linhas retas: Marque com um cligue onde deseja que a
reta inicie e com outro cliqgue onde deseja que ela termine.

» Para desenhar curvas: Posicione a ferramenta onde deseja que a curva
inicie. Mantenha o botdo do mouse pressionado. O primeiro ponto de
ancora aparece, e a ponta da caneta muda para uma ponta de seta.
Arraste na direcdo em que deseja desenhar o segmento de curva. Ao
arrastar, as alcas tangentes da curva aparecem. Solte o botdo do mouse.
O comprimento e a inclinagdo da alca tangente determinam a forma do
segmento de curva. Vocé poderd mover a alca tangente mais tarde para
ajustar a curva. Posicione o ponteiro onde deseja que o segmento de
curva termine, mantenha o botdo do mouse pressionado e arraste na
direc&o oposta para completar o segmento.

= Quando se estiver tracando as retas, se mantida pressionada a tecla
Shift, as retas serdo restritas a angulos multiplos de 45°.

A Texto [T] — Com esse botdo vocé pode criar campos editaveis de texto. Ao
clicar na tela de pintura com a ferramenta Texto surgira um circulo no canto direito
superior da area para ser digitado seu texto. Clique no circulo e arraste até onde
deseja que seja feita a quebra de linha de seu texto. Nesse momento surgira um
guadrado no lugar do circulo, que indica que aquela area de texto tem seu tamanho
limitado.
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Oval [O] — Traca formas ovais ou circulares. Quando se esta usando a
ferramenta, surge um pequeno circulo junto ao seu cursor. Quando esse pequeno
circulo aumentar de tamanho e seu contorno ficar mais forte, vocé acaba de
conseguir um circulo perfeito. Outra maneira de se obter circulos perfeitos € manter
pressionada a tecla Shift enquanto se traca a figura.

Retangulo [R] — Traca formas retangulares ou quadradas. Assim como na
ferramenta Circulo, quando o pequeno circulo junto ao cursor se tornar maior e de
contorno mais forte vocé tera um quadrado perfeito. Da mesma, forma se
segurarmos a tecla Shift durante o desenho da figura, também teremos um
guadrado. Possui a seguinte ferramenta modificadora:

r
o Round Rectangle Radius — Esse modificador abre a caixa de
didlogo Rectangle Settings, na qual vocé pode definir o raio que cria a
forma arredondada dos retangulos. Quanto maior os valores, mais
arredondados seréo os cantos.

ﬁ. Lapis [Y] — A ferramenta do Lapis é bastante versatil. Com ela vocé criara
todos os contornos dos elementos gréaficos do seu projeto. Para usar o Lapis, basta
aplicar o ponteiro do mouse sobre a tela de pintura, manter o botdo esquerdo
pressionado e arrastar 0 mouse. Se vocé mantiver a tecla Shift pressionada, vocé
terd tracos perfeitamente horizontais e verticais, dependendo do sentido que se
arrastar o mouse. Seus modificadores sé&o:

= Pencil Mode — Esse botdo abre um menu com trés op¢des que modificam
0 comportamento do lapis:

. LJ Straighten — Traca linhas retas ou angulosas. Se vocé desenhar
linhas arredondadas com essa ferramenta, ao soltar o0 mouse as partes
arredondadas s&o convertidas em linhas retas, e curvas mais
acentuadas serao convertidas em angulos.

S

T 4 Smooth - Traca linhas arredondadas ou suavizadas. As linhas
desenhadas com esse modificador ligado apresentam
arredondamentos mais suaves, mesmo se Vvocé desenhar linhas
angulosas. Os angulos acentuados séo arredondados.

3%‘ Ink — Traga linhas livremente, sem torna-las mais retas ou
arredonda-las demais. Uma vez solto o mouse apos o tracado de cada

10
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@F . Pincel [B] -

linha, é aplicado um certo arredondamento, tornando a linha mais
suave, mas de maneira menos acentuada do que com o modificador
Smooth ligado.

O pincel é uma das ferramentas de pintura mais versateis do

Flash. Seus modificadores séo:

Brush Mode — Esse botdo abre um menu suspenso no qual vocé podera
escolher o comportamento do pincel

4 Paint Normal - Pinta normalmente sobre qualquer coisa,
encobrindo tudo o que estiver por baixo.

|
EJ Paint Fills — Pinta somente sobre cores que nao tiverem sido
criadas pelo lapis, ou seja, suas cores sO “pegam” sobre pinturas feitas
com a lata de tinta ou do préprio pincel. Cores modificadas pelo frasco
de tinta também néo séo afetadas, ja que se limitam aos tragcos criados
pelo lapis.

4| Paint Behind — Com essa opcdo ativa, o pincel pinta somente
“por trads” das cores ja existentes. Em outras palavras, pinta somente
sobre as areas vazias da tela de pintura.

4 Ppaint Selection — Pinta somente dentro de areas selecionadas

com a seta. Pinta somente sobre cores que ndo tenham sido criadas
pelo lapis.

|

4| Paint Inside — Pinta somente na area em que a pintura foi
iniciada. Por exemplo, se vocé comecar a pintar sobre a tela e avancar
para uma figura fechada, a pintura ndo ultrapassara a linha, deixando
as linhas que formam a figura e o seu interior intactos, continuando a
pintura “do lado de fora” da figura. Se vocé avancar a pintura sobre
uma linha ndo fechada, a pintura prosseguird do outro lado da linha,
sem afeta-la, como se estivesse pintando “por tras” dela.

v
| . :l Brush Size — Esse botdo abre uma lista suspensa com

diversas opc¢Oes de tamanho para a ponta do pincel.

11
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. Brush Shape — Esse botdo abre uma lista suspensa com
diversas opc¢Oes de formatos para a ponta do pincel.

_I;i: Lock Fill — Controla a aplicacéo de cores com efeito de degradé. Se
estiver ligado, todas as formas pintadas com o mesmo gradiente serdo
apresentadas como se fossem uma Unica forma, com um degradé
continuo por toda a tela de pintura. Se estiver desligado, cada forma
pintada com o mesmo gradiente tera seu efeito proprio, independente das
demais.

(i

Lapis.

Nanquim [S] — O frasco de tinta modifica as cores dos tracos feitos pelo

f@ Balde de Tinta [K] — A lata de tinta pinta o interior de figuras fechadas. Seus
modificadores séo:

» Gap Size — Esse modificador abre um menu de opcbes de controle de
tolerancia da ferramenta de pintura quanto a objetos fechados. As opc¢des
séo:

. G-l Don’'t Close Gaps — Com essa opc¢do selecionada, a lata de tinta
nao pintara o interior de figuras que tiverem alguma abertura, por menor

gue seja (isto ndo inclui linhas formadas por estilos de Lapis formados com
pontos ou tragos, desde que estejam fechadas).

. 4 Close Small Gaps — Com essa opcéo selecionada, a lata de tinta
pintara o interior de figuras que apresentarem aberturas muito pequenas.

. 4 Close Medium Gaps - Com essa opcao selecionada, a lata de tinta
pintard o interior de figuras que apresentarem aberturas de tamanho
meédio.

. 4 Close Large Gaps - Com essa opcdo selecionada, a lata de tinta

pintara o interior de figuras que apresentarem aberturas grandes.

@

Lock Fill - Mesmas propriedades do modificador da ferramenta Pincel.
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ﬁﬂr

. " Transform Fill — Apos a aplicacdo de um degradé, ative essa opcgéo e
cligue sobre a area pintada. Surgird& um circulo com trés “alcas” de
transformacdo, com as quais vocé podera modificar o tamanho do degradé,
gira-lo ou distorcé-lo. Se as alcas ficarem ocultas fora da tela, va até o menu
View e selecione a opcéo Work Area.

ﬁ? Conta-Gotas [I] — Essa ferramenta capta informacdes de cores e estilos, para
gue vocé possa desenhar com tais parametros, ou aplica-los a outras partes do
desenho. Ao posicionar 0 conta-gotas sobre uma linha, repare que surge um
pequeno icone com formato de lapis ao lado do conta-gotas, indicando que, se vocé
der um cligue sobre aquela area, sera ativada a ferramenta de lapis, assumindo os
parametros de espessura, cor e estilo da linha sob o conta-gotas. O mesmo
acontecera se vocé posicionar o conta-gotas sobre uma area pintada. Surgira um
pincel ao lado do conta-gotas. Ao dar um cligue sobre a area, sera ativada a
ferramenta da lata de tinta, assumindo todos os parametros que foram utilizados na
area que estiver sob o ponteiro do mouse. A partir dai, em ambos os casos, basta
clicar sobre uma linha ou uma area colorida para transferir os parametros de um
elemento para outro.

Borracha [E] — A borracha apaga linhas e cores da tela de pintura, e pode
assumir diversos formatos e comportamentos diferentes, de acordo com o
modificador escolhido. Seis modificadores séo:

» Eraser Mode — Esse botdo abre um menu suspenso em que vocé podera
escolher o comportamento da borracha. As opcfes sdo as seguintes:

Y

« ™4 Erase Normal — Apaga todo e qualquer elemento da tela de
pintura.

= "4 Frase Fills — Apaga somente as cores aplicadas com as

ferramentas de pintura. Nao apaga as linhas produzidas pelo lapis.

oy

. 4 Erase Lines — Apaga somente as linhas, deixando intactas as
cores produzidas pela lata de tinta e pelo pincel.

" 4 Erase Selected Fills — Apaga somente as areas selecionadas
de cores aplicadas com as ferramentas de pintura.

13
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. 4 Erase Inside — Apaga somente na area em que a acgdo de
apagamento foi iniciada.

" E'_ﬁ[| Faucet — Com essa ferramenta ligada, basta clicar sobre a linha ou
area colorida que deseja apagar, e toda a linha ou area colorida sera
apagada de uma s6 vez. Se vocé selecionar uma area, um cliqgue com a
ferramenta faucet ativada apagara toda a area selecionada, mesmo que
englobe linhas, segmentos de linhas e trechos de areas coloridas ao
mesmo tempo.

v
. —| Eraser Shape — Controla a forma e o tamanho da ponta da
borracha, que pode ser redonda ou quadrada.

m
2 J . Mao [H] — Movimenta livremente a tela de pintura.

g] Lupa [M ou Z] — A lupa amplia ou reduz o tamanho com que a tela de pintura
€ apresentada na area de trabalho. Seus modificadores séo:

@

= _F Enlarge — Amplia.

s

= __ " Redunce - Reduz

al

Stroke Color — Define a cor da ferramenta Lapis e Nanquim.

ﬂ Fill Color — Define a cor do Pincel e do Balde de Tinta.
2.4 - PAINEIS DE CONFIGURA(;AO

Painel Misturado Painel de Instancia Painel de Actes

!

) - @ O m-yi J la de Bibliot
Painel delnformacoes—ﬁ @ n'—.lg A anela de biblioteca

Movie Expblorer
Painal Ae Carartara
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Os painéis flutuantes ajudam a exibir, organizar e alterar elementos em um
filme. As opc¢Bes disponiveis nos painéis controlam as caracteristicas de elementos
selecionados. Os painéis do Flash permitem que vocé trabalhe com objetos, cores,
textos, instancias, quadros, cenas e filmes inteiros.

i0

Painel de Informacdes — Exibe informacdes a respeito de graficos, transforma

geometricamente algumas figuras, exibe informacdes sobre o traco do lapis, além de
possuir um editor para as cores da paleta, inclusive com um editor para os degradés.

o |
i1 Info| 227 Transfo] == Stroke| @5 Fill | (‘_Ji
ok Shape
o wifssn wifszo
T R O
B
sg +. 8o
A

Aqui o painel exibe informagbes a
respeito da figura selecionada, tais
como sua altura e comprimento, além
de sua posicéo na tela de pintura.

Tranzform

T |nf]§ Transtorm| 2 & g5 Fin| (2 [ ]

8
[0 § imu.nz [V Constrain

{* Fotate &

) Skew _47|_ %I_
jecliad

Com esse painel ativo, ao selecionar
uma figura é possivel mudar alguns de
seus atributos, tais como o alterar seu
tamanho, aplicar uma rotagdo ou uma
deformacéo.

Strake

{3 Info gTr’aﬂ ‘f,’i’Sterei @ .

I Solid Ll

Aqui vocé modifica as propriedades do
traco, tais como: o estilo (que pode ser

it -l sélido, pontilhado, irregular, etc.), a
espessura e a cor.
Fill ]

([ Infa] 7 Trans] 2 Strak] 5 Fil | (2) : I

I Linear Gradient

'—Fﬁ

Com esse painel, é possivel aplicar e
modificar as cores de um objeto.
Nesse painel é possivel alterar as
cores de um degradé, editando-o com

uma paleta de cores.
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Misturador — Com esse painel sdo editados as cores tanto de traco quanto de
preenchimento das figuras. E possivel alterar essas cores através de uma lista
padrdo, que conta com alguns tipos de degradés ou com os padrdoes RGB. Também
nesse painel é possivel aplicar graus de transparéncia aos objetos.

Mine =]
Mixer[ﬁ E;watches] @

7 ﬂ F: |?s [
Yy Glo 7 Padrdo RGB
e =3 IU x
Ll Aphz[e0: = Efeito de Transparéncia

Aqui se encontra uma paleta de
cores sdlidas, com alguns tipos de
degradés, que podem ter suas
cores editadas com o Painel Fill,
visto anteriormente.

A Painel de Caractere — Aqui vocé define os atributos de fonte e de paragrafo

do texto. Uma fonte € um conjunto de caracteres alfanuméricos de determinado
desenho de tipo. Os atributos de fonte incluem, entre outros, a forma da fonte, o
tamanho do texto, o estilo, a cor, 0 espacamento entre letras automético e o
deslocamento da linha de base.

A Character[ L] F'aragraph] @ : |

Tamanho da Fonte 1\F‘2:>|Tlmes —» Tino de Eante
| J B| 7 E\
NistAncia entre caracteres K
Ak »  Corda Fonte
. . ,ﬁ,¢ IMDrmaI I
<+—

Subscrito / Sobrescrito

URL:
Inserir | ink 4/L4’ A Negrito e Italico
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Paragraph | x| .
Alinhamantn

Margem Esquerda L = o
9 g « = -] =j'*|”P“ —= 1y Margem Direita

Reciin / \K

A

Espaco entre linhas

£l

3% painel de Instancia — Esse painel age diretamente sobre as instancias dos
simbolos e/ou os quadros da linha do tempo em que eles se encontram. As
instancias serdo discutidas posteriormente. Trataremos apenas das principais
funcdes desse painel.

Define o comportamento do simbolo como

)\ um Movie Clip, Gréfico ou Botdo
%] symbol 1

Eehavior: I Mowie Clip ;»i/

Mame: | /

sz v

/
—» Duplica o simbolo

Acrescenta uma acao ao seu simbolo

Leva para a janela de edi¢do do simbolo

X

2T Jin=t{ i | Effect| 2] Fra

Aqui sdo editados os

P 5| Al efeitos relacionados a
Mone . ~ . ,

Evightness instancia dos simbolos,
A tais como sua
Aduanced transparéncia, brilho,

contraste, etc.

Frame | x| . .
=L Painel para edicdo

dos quadros da linha
Lt do tempo. Pode tanto

Tweening:IMc\tiDn vI pScale Crial‘ como editar as

&l linztd 8", |Efte| &[] Frame|[ |l Sou

Easing:|5|:| jDut animagc")es de cada
Rotate: | i =] [0 times quadro.

Options: | Mone th
Auto I— Snap
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Sound
E'.:Hnst; i |Efrel 8] Fraa [#= Sound I (7] : |
Sound: I Mone ;I . ~
Edita acOes referentes
Mo sound selected.
: aos sons dessa
Effect [110n- =l e instancia do simbolo ou
Syne: I Event ;I filme
Lcn:-ps:lﬂ

ﬁ Movie Explorer - O Movie Explorer fornece um método facil para exibir e
organizar o conteudo de um filme e selecionar elementos no filme para modificacao.
Ele oferece varios recursos para agilizar o fluxo de trabalho na criacéo de filmes. Ele
localiza e oferece a opcao de editar qualquer elemento do simbolo.

Movie Explarer

A Mawie Explnrer[ i Object .ﬁ.cti-:-nsl (7)

Shnw:AE@EEE

L Abrir menu de

Caixa de Texto Find: |

L

Opcodes

» Botdes de Filtragem

Localizar
% Scene 1

Lista de Exibicdo <
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ﬁ Object Actions — Painel que também vem incorporado ao Painel do Movie
Explorer. Serve para editar e acrescentar agées aos seus simbolos.

ct Achions

Q!Mnl.lie Explorer| Zi Object .ﬁ.ctinnsi @ :l
F= hil=

[E] Basic actions = Em cada item s&o
@ coTo | oferecida uma série de
@ Py » | acbes, operadores, etc.
@ s L‘ para serem aplicadas aos

| Mo achon zelected. simbolos.

Mo Parameters.

m Biblioteca - Talvez o painel mais importante do Flash. Uma biblioteca em um
filme do Flash armazena simbolos, incluindo os criados no Flash e os importados
para ele, e permite que vocé exiba e organize esses arquivos ao trabalhar. A janela
Biblioteca exibe uma lista de rolagem com os nomes de todos os itens da biblioteca.
Um icone ao lado do nome de um item nessa janela indica o tipo de arquivo do item.
Quando vocé seleciona um item na janela Biblioteca, uma visualizagdo em miniatura
do item aparece na parte superior da janela. Se o item selecionado for animado ou
se for um arquivo de som, use o Controlador para visualiza-lo.

Library - kowi

Options

Exibic&o do item selecionado
Vocé pode armazenar

seus simbolos em pastas

\ | Narme
I~~~

ﬁ Pastal

L 123 Symbold

i 1 Syrnbal 2
Lista dos simbolos €] (£
do filme Symbol 3

Exibe as propriedades do
Pal simbolo

Exclui simbolo

/V

C”a um novo S|mb0|0 4_ E' ﬁ ﬂ ﬁ LI—I Cna uma pasta para
| » armazenar os simbolos
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macro a ~ CAPITULO Il
ISH TECNICAS BASICAS DE
bdiitee ANIMAGCAO

A criacdo de animacéo no Flash é feita mudando o contetdo do palco numa
sucesséao de quadros. O principio € o mesmo de um filme tradicional, em que uma
sucessao de slides cria a ilusdo de movimento.

Para produzir efeitos de animacao, séo feitas alteragbes a cada novo quadro
da sequéncia. No Flash, todo quadro que contém alguma alteracdo € chamado
Keyframe, ou quadro chave. O Flash representa os quadros da animacdo em
divisdes sobre uma linha, chamada de Timeline, ou linha do tempo.

Vocé usara a Linha do Tempo para deslocar-se pelos quadros da animagéo,
criar novos quadros e executar inimeros comandos na criagdo dos filmes.

Ha duas maneiras de criar animacdo no Flash: quadro a quadro e com
tweening. Na animacdo quadro a quadro, vocé deve criar manualmente a cada
guadro da animacdo, implementando as diferengas necessarias para produzir o
efeito de movimento. J& na animagédo com tweening vocé define somente o primeiro
e o0 Uultimo quadros da sequéncia, e deixa que o computador -calcule
automaticamente os quadros intermediarios.

Além da divisdo em quadros, a Linha do Tempo divide-se também em
Camadas (ou Layers). As camadas funcionam como diversas folhas de plastico fino
e transparente, cada um contendo uma animacéo ou efeito. Cada camada possui
sua proépria estrutura, independente de tela de pintura e varios niveis sobrepostos.

Torna invisiveis o0s

elementos da camada Linha do Tempo

Camadas /
\ NI
e |[=
[ Layer 1 + + [ || .
[ 4| @@ Bl E[ 8 [12o6s [ 02s
Trava o0s elementos da/ *
camada, impossibilitando
serem alterados. Deixa visivel apenas o
contorno dos elementos
da camada.
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3.1 - ANIMACAO QUADRO A QUADRO (FRAME BY FRAME)

E a mais simples, porém a mais trabalhosa. Para criar animagdes quadro a
guadro (como o préprio nome sugere), é necessario que se defina todos os quadros
da animacdo, ou seja, todo quadro é um quadro-chave (keyframe).

O proximo passo entdo é criarmos uma simples animacao
quadro a quadro. Comece desenhando a figura ao lado,
lembrando que os olhos sédo elementos graficos separados. Com
isso jA temos a imagem do primeiro quadro da sequéncia da
animacao.

O proximo passo sera acrescentar mais um keyframe.
Cliqgue com o botdo direito do mouse sobre a representacdo do
quadro 2 na linha do tempo e selecione a opcédo Insert Keyframe
Nno menu que surgird, ou pressione a tecla F6.

A partir de agora, as alteracdes que vocé fizer no desenho vao afeta-lo
somente no quadro indicado pelo ponteiro, que neste caso é o quadro 2. o desenho
permanecera intacto no quadro 1.

Selecione o desenho com a ferramenta Seta e selecione o botdo Rotate.
Utiliza a alga superior central e arraste o desenho para a direita, criando uma leve
inclinacao na figura.

Avance o ponteiro para o quadro 3 na linha do tempo e crie
um keyframe. Agora queremos fazer com que o personagem volte a
posicdo inicial para criar um movimento de balanco. Uma das
maneiras de fazer isso é usar 0 botdo Rotate da Seta para ajustar o
desenho para a posicao original. Contudo ha uma maneira mais facil,
por meio de um comando que vocé utilizara muitas vezes em suas
criacbes no Flash. Primeiro volte o ponteiro até o primeiro quadro. Selecione o
desenho, va até o menu Edit > Copy ou pressione as teclas Ctrl+C. Em seguida,
retorne o ponteiro até o quadro 3. volte ao menu Edit e selecione a op¢éo Paste in
Place, ou pressione Ctrl+Shift+V. Sera colocada uma copia do desenho do quadro
1 exatamente na mesma posi¢do. Movimente o ponteiro de um lado para o outro
para ver como esta ficando.

Avance o ponteiro até o quadro 4 da linha do tempo e crie um keyframe. La
estard o personagem com a mesma posi¢ao do ultimo keyframe. Agora faremos som
que o personagem se incline para a esquerda, novamente usando o
bot&o Rotate. @ @

Finalmente, vamos adicionar um toque na animagao do
personagem. Avance o0 ponteiro para o quadro final e crie um
keyframe. Selecione exclua a ilustragdo nesse quadro, va até o
quadro 1 e novamente selecione e copie 0 personagem e cole no
Gltimo quadro usando Paste in Place do menu Edit
(ou Ctrl+Shift+V) para fazer a copia do desenho exatamente no
mesmo lugar dos demais.

Com a Seta clique sobre os olhos do personagem e os deslogue um pouco
para cima, separando-os do corpo do personagem.
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A animacdo esta completa. Va até o menu Control e
marque a opc¢ao Loop Playback e, em seguida, pressione
Enter para ver o resultado. Para interromper a execucao
pressione Enter novamente.

Outra opcdo que ajuda bastante quando se esta
@ @ fazendo uma animac¢do quadro a quadro é a de Onion Skin .
Com ela é possivel visualizar os quadros anteriores em cada

guadro da animagé&o.

Quadros anteriores mostrados com a
opcao Onion Skin

3.2 - TWEENING (ANIMACAO LINEAR)

O Tweening é a principal forma de animacdo no Flash, € uma maneira mais
facil de se animar, basta definir o quadro chave inicial e o quadro chave final e
comandar ao flash que realize o tweening. O Flash detecta a mudanca e “tenta
adivinhar” qual era o movimento desejado.

Vejamos entdo como utilizar o tweening. Inicie um projeto novo e coloque um
elemento grafico na tela de pintura, no primeiro quadro. Clique com o botédo direito
do mouse no quadro 20 e selecione a op¢ao Insert Frame.

Com a Seta selecione o elemento gréafico.

No menu Insert selecione a opcao Create Motion Tween. O Flash criara uma
linha pontilhada entre o primeiro keyframe e o final da sequéncia de quadros (essa
linha pontilhada indica um tweening incompleto). Clique na posi¢cdo 20 para deslocar
0 ponteiro até esse quadro. Cligue com a Seta sobre o elemento e arraste-o até a
posicdo desejada. Assim que vocé soltar o mouse, o Flash transformara a linha
pontilhada em uma seta cheia, e o Ultimo quadro da sequéncia sera transformado
em um keyframe. Aperte Enter e confira a sua animacéao.

3.2.1 - Aceleracao e Desaceleracéo

Na animag&o anterior, o elemento faz o percurso com uma velocidade
constante. Se vocé quiser fazer com que a velocidade seja constante no inicio e haja
uma desaceleracdo, devera editar o tweening. Para isso deixe o ponteiro no quadro
1 e clique no painel de Instancias.

Selecione o painel Frame. Na opcdo Easing desloque o controle deslizante
até o final, de modo que o valor seja 100. Para conseguir o efeito oposto, ou seja,
fazer com que o elemento inicie o percurso lentamente e apresente uma aceleracao,
repita o processo anterior, so faca com que o Easing fique com o valor de —100.
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Se vocé quiser dar ao movimento do objeto
m'ﬂ'“ﬂ i JEfie] £l F'amm“55°” 9 um comportamento mais realista, e quiser criar
Label:| aceleracao no inicio e desaceleracéo no final, devera

Tweening:lr‘-*lminn ] W Soale dividir o processo em duas seqiéncias, criando um

Easing: [100 | Out keyframe no meio da seqiiéncia.

Fh:\tate:lm - ID—times

Optians: [ 0 topath

|7 S ranize [v Snap

3.2.2 — Rotacéo

Vocé pode também usar o tweening para fazer um objeto
girar. Inicie um novo projeto. Com 0 ponteiro no quadro 1 da
linha do tempo, desenhe um circulo, apés divida-o com uma
linha em duas partes. Pinte cada metade de uma cor. Agora use
a Seta ou a Borracha com o botdo Faucet para apagar a linha
divisoria.

Com o botdo direito do mouse insira um Frame na
posicdo 10 da linha do tempo. Volte para o quadro 1, selecione
0 objeto com a ferramenta Seta, e clique com o botédo direito do
mouse no quadro 1, selecionando a opgdo Create Motion
Tween. Va para o quadro 10, selecione o desenho e arraste-o até a posi¢éo
desejada. Clique no painel de Instancias e selecione o painel Frame. Na opg¢éo
Rotate selecione CW (Clockwise), e digite um valor no quadro ao lado da palavra
times. Esse valor sera o nUmero de giros que o elemento devera dar no percurso
entre os dois pontos.

3.2.3 — Tweening com Movimento Sobre um Caminho Irregular Definido

Os exemplos de tweening que vimos até aqui produzem movimentos
uniformes. Contudo, também é possivel definir um trajeto irregular especifico para
um elemento gréfico.

Com o desenho ao lado, crie uma animagao com tween.
Va até o menu Insert e selecione a opcdo Motion Guide.
Opcionalmente, clique com o botdo direito do mouse sobre o
nome da camada para abrir 0 menu e selecione a opcao
Add Motion Guide.

O Flash criara uma camada na linha do tempo, acima da camada selecionada,
denominada Guide Layer 1. Repare que ha um icone antes do nome da camada,
gue indica tratar-se de uma camada de guia de tracejo. repare também que a
camada guia foi selecionada. Isto significa que o0 que vocé tracar na tela de pintura
sera aplicado o primeiro quadro da nova camada, e que ha um icone representando
um lapis logo ap6s o nome da nova camada. Esse icone indica que a camada esta
sendo editada no momento (veremos mais detalhes sobre camadas posteriormente).
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b Guide: Laver 1
P Layer

Camada de Gilia

Com o lapis trace uma linha na tela. Essa linha sera a guia que definira o
caminho a ser percorrido pelo objeto animado por tweening na camada inferior. Se a
caixa de selecdo Snap do painel Frame estiver selecionada, o desenho sera
encaixado imediatamente na extremidade inicial da linha. Pressione Enter para ver a
animacdo. O desenho devera percorrer toda a linha até sua extremidade. Se isto
nao acontecer, é sinal que essa extremidade foi tragcada muito afastada do local final
original do tweening. Para corrigir isto, clique no quadro final do tweening, na
camada de tweening e, com a Seta, arraste o desenho até a extremidade final da
linha.

Se quiser ocultar a guia de percurso, cligue sobre 0 ponto
localizado logo abaixo do icone de olho, na camada da
guia. Surgira um “X” vermelho sobre o ponto, indicando
gue o contetdo da camada ndo estd sendo apresentado

na tela.

Vamos agora acrescentar uma linha de modo
com que facamos o carro subir uma ladeira. Ao
executar a animacao vocé vera que o efeito deixou
muito a desejar, pois 0 carro ndo se inclinou ao
iniciar a subida, como mostra a figura ao lado. Para
gue o movimento fique correto, € preciso que 0
carro permaneca paralelo a linha do que representa o chdo. Abra o painel Frame e
marque a op¢do Orient to Path. Execute a animacdo e veja como o resultado
melhora bastante.

3.2.4 — Tweening com Alteracdo de Formas

A alteracdo animada de formas pode somente ser feita em imagens, e essas
imagens devem estar na mesma camada (como ja foi dito, as camadas seréo
discutidas posteriormente). Para criar esse tipo de efeito, proceda da seguinte
maneira:

» Crie um keyframe, para isso cligue com o botédo direito na linha do tempo e

selecione a opgéo Insert Keyframe, ou pressione a tecla F6.

= Crie aimagem inicial. Por exemplo um circulo.
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Crie um keyframe ap6s o nimero desejado de quadros para a animacao,
15, por exemplo. Com o botéo direito do mouse insira um keyframe no
quadro 15 da linha do tempo.

Crie uma segunda imagem no quadro do segundo keyframe. Para isso
clique sobre o quadro 15 (ou no quadro em que se encontrar o keyframe)
e faca seu desenho. Além do formato, o segundo desenho podera ter
também cor, tamanho e posicao diferentes.

Cligue no primeiro quadro da animacéao e abra o painel Frame. No menu
suspenso Tweening selecione a opcdo Shape. O parametro seguinte,
BlendType, define a maneira com que a transi¢céo vai ser processada. A
opcao Distributive faz com que as formas intermediarias sejam mais
suaves e irregulares. A opcdo Angular é mais adequada para imagens
com muitos cantos e linhas retas. O controle deslizante Easing determina
a aceleracao, e ja foi visto seu funcionamento anteriormente. Veja abaixo
alguns quadros da animacé&o.

Havera casos em que a transicdo ndo serd perfeita, devido ao formato das
imagens inicial e final. Nesses casos, serad preciso usar guias para auxiliar na
transicdo. Para exemplificar, vamos fazer um morphing entra os algarismos 1 e 2.

Com o auxilio do painel de Caractere, escolha um tamanho de fonte
razoavel e digite o numero 1.

Como néo é possivel alterar a forma de blocos de texto, teremos que
transformar o bloco em uma forma comum. Para isso, cligue com Seta
sobre o numero e pressione Ctrl+B, ou va até o menu Modify e selecione
Break Apart. A partir de agora o “1” deixou de ser um bloco de texto, e
passou a ser um elemento grafico comum.

Proceda como no exemplo anterior para criar o keyframe e os quadros
intermediarios. Para criar a segunda imagem, faca 0 mesmo que fizemos
com o numero “1”, sendo que agora digite o numero 2. se achar que o
tamanho da imagem do namero nao ficou satisfatério, e quiser amplia-la,
selecione com a Seta e use o botdo Scale para ajustar seu tamanho.
Clique no primeiro quando da animacao e selecione o painel Frame. No
menu suspenso Tweening selecione a op¢éo Shape.

Pressione Enter e veja que a animagao deixa muito a desejar.

4 a2
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Para resolver este problema, vamos acrescentar duas guias as imagens, para
orientar transigao:

» Clique no primeiro keyframe da sequéncia para seleciona-lo.
Va até o menu Modify, selecione a opcdo Transform
e selecione a op¢do Add Shape Hint. O Flash aplicara uma
guia sobre a imagem, representada por um ponto vermelho
com a letra “a”.

* Mova a guia até o ponto desejado sobre a imagem. Neste
caso, coloque a guia sobre o canto esquerdo do “1”.

= V& novamente até o menu Modify, selecione a opg¢do Transform e
selecione a op¢do Add Shape Hint. O Flash aplicara mais uma guia
vermelha sobre a imagem, representada por um ponto vermelho com a
letra “b”. desloque essa guia até o canto inferior direito do “1”.

= Agora desloque o ponteiro até o keyframe final da sequéncia. Desloque as
guias “a” e “b” em posicdes equivalentes sobre a imagem do “2”.

» Pressione Enter e verifique que a animacéo tem um feito bem superior.

1122
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macro a CA,PI'TULO \Y;
1SH SIMBOLOS

bl It

Um simbolo é um grafico, botdo ou clipe de filme que vocé cria uma vez e,
depois, pode reutilizar em todo o filme ou em outros filmes. Qualquer simbolo criado
automaticamente torna-se parte da biblioteca. Uma instancia é uma cépia de um
simbolo localizado no palco ou aninhado dentro de outro simbolo. Uma instancia
pode ser bastante diferente de seu simbolo quanto a cor, tamanho e funcdo. A
edicdo do simbolo atualiza todas as suas instancias. No entanto, a edicdo de uma
instancia de um simbolo s6 atualiza essa instancia.

O uso de simbolos nos filmes reduz consideravelmente o tamanho do arquivo.
Salvar diversas instancias de um simbolo requer menos espaco de armazenamento
do que salvar uma descricdo completa do elemento em cada ocorréncia. Por
exemplo, vocé pode reduzir o tamanho de arquivo dos filmes se converter gréficos
estaticos, como imagens de fundo, em simbolos que podem ser reutilizados. Existem
trés tipos de simbolos:

¥
Lo Graphic (Gréfico): Ideal para elementos que nao interagem com o filme, a linha
de tempo dos simbolos do tipo grafico correm junto com a linha de tempo principal.
N&o realizam acao, nem recebem interacéo.

b
—— Movie Clip (Clipe de Filme): Semelhante ao grafico, porém possui linha de
tempo independente, um clipe de filme se comporta como um arquivo flash a parte,
pode executar agdes e receber controle e interacao externa.

':I Button (Botédo): Um simbolo do tipo botdo, responde a eventos do mouse (up,
over, down, e hit) e executa acoes.

Para criar um simbolo, va ao menu Insert > New Simbol, ou utiliza a tecla de
atalho Ctrl+F8. E possivel criar um simbolo a partir de objetos selecionados no
palco. Para isso, selecione o objeto e v4 ao menu Insert > Convert to Symbol, ou
simplesmente pressione F8 apds 0 objeto estar selecionado.

Symbol Properties

Logo apos indicar Hame: INu:.rne do Simbolo

il

0] nome, vocé

selecionando qual tipo Eshavior: | & tovie Clip Cancel
de simbolo estara " Buttan

criando " Graphic Help
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Os simbolos podem ter toda a funcionalidade que vocé pode criar com o
Flash,inclusive a animacéao.

Ao utilizar simbolos com animacdo, vocé pode criar filmes com bastante
movimento e ainda minimizar o tamanho do arquivo. Procure criar animagdo em um
simbolo quando existir uma acao repetitiva ou ciclica — por exemplo, 0 movimento
para-cima e para-baixo de uma bola picando.

Outra opcgdo bastante util € a duplicacdo de Simbolos. Abra a biblioteca,
selecione o simbolo na lista e cligue com o botdo direto do mouse. Nesse menu
flutuante que se abre cliqgue na opc¢éo Duplicate.

Depois de criar um simbolo, vocé pode criar instancias desse simbolo sempre
gue desejar em todo o filme, sem afetar o simbolo.

4.1 - GRAFICOS

Para criar um grafico, além da forma descrita anteriormente, vocé pode
simplesmente desenhar um elemento grafico na tela de pintura, ir a0 menu Insert e
escolher a opcdo Convert to Symbol (ou pressionar a tecla de atalho F8).

Selecione o menu Insert > New Symbol. Marque a opcédo Graphic e nomeie
o simbolo para Circulo. Vocé passa imediatamente para a janela de edicdo desse
simbolo, observe também que esse simbolo ja consta em sua biblioteca.

[B i (8 B i pally [l farial Brsde B Lzl
g &mn B oao - E -

| 5 Seama -

Pty
& [
&
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T |
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Aqui indica que vocé esta na
janela de edi¢cdo do seu simbolo.
Se clicar no botdo ao lado,
Scene 1, vocé voltara ao palco
principal

o = ] .--.-.lljﬁf-‘:f
Voltando ao palco, ou tela de pintura, abra o painel de Biblioteca e arraste o
simbolo para o palco. Agora iremos trabalhar com a instédncia desse simbolo, sem
esquecer que qualquer alteracdo feita aqui ndo alterara a forma original do gréfico.
Com o painel de Instancias temos uma série de opc¢les para edicdo da
instancia desse simbolo, como cores acbes e etc. Acione 0 painel e teste suas
opcoOes (o painel de Instancias ja foi apresentado anteriormente).
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4.2 — MOVIE CLIPS

Como dissemos no inicio do capitulo, os Movie Clips sdo pequenos trechos e
animacao que funcionam independentes da linha do tempo do filme principal. Podem
conter sons,controles interativos e instancias de outros Movie Clips.

Para construirmos nosso Movie Clip usaremos o0 desenho do carro, usado em
exemplos anteriores.

Selecione o desenho do carro, va ao menu Insert e selecione Convert to
Symbol, ou simplesmente pressione F8. No painel que se abrird, marque
Movie Clip e dé um nome ao simbolo.

Com um duplo clique no simbolo v& para sua &rea de edigdo. Crie seis
keyframes. Nos ultimos trés keyframes pinte o farol do carro de preto.

A partir do segundo keyframe, sucessivamente até o quinto keyframe, va
desenhando pequenos riscos saindo da parte traseira do carro, simulando
um cano de descarga.

Feito isso, va ao menu Control marque a opcao Loop Playback

Abaixo, como deve ficar os seis keyframes do seu movie.

G B

G
G

O Movie Clip pode ser tratado na tela do filme principal como qualquer outro
elemento. Vamos usar o mesmo Movie Clip e inserir uma pequena animacdo com
tweening. Para isto, proceda da

seguinte maneira: & femt =

o Tl

Com a ajuda da biblioteca, e

insira seu Movie Clip na
extremidade do lado
esquerdo.

Com o botdo direito do
mouse, selecione a opgao e
Insert Frame no quadro

50 da linha o tempo.

Volte ao quadro 1, clique

com o botdo direito do |, o
mouse e va em Create Motion Tween.

No quadro 50 arraste o Movie Clip para extremidade direita da tela
Pressione Ctrl+Enter para ver o resultado da sua animacgao

o] o ol B e e ]
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4.3 -BOTOES

Botbes sédo elementos que respondem a eventos do mouse (como cliques ou
a simples passagem do ponteiro sobre o botéo), disparando ac¢des dentro do filme.
Podem conter Movie Clips com animacdes, que mudardo de comportamento de
acordo com a movimentagdo ou 0 evento do mouse, podem alterar a sequiéncia de
um filme, alterar a sequéncia da animacdo de um Movie Clip, ligar ou desligar
animacdes, sons, enviar e-malil, carregar filmes do Flash ou paginas a internet.

Scenel (g botdo A 4
B Scenel G Va até o menu Insert e

& g |:|||_uu|:wer||:|-:wr4 Hit | selecione a opcdo New Symbol. Na

| caixa de didlogo Symbol Properties

marque a opc¢éo Button e dé um nome
gualquer. Observe as diferencas na
linha do tempo. Os quadros sdo mais
(®) g7 || @mlal sl el 1 largos, e os primeiros quatro quadros
estdo identificados como Up, Over,

Down e Hit. Veja em seguida o significado de cada quadro:

= Up — E o botdo em seu estado natural, sem qualquer alterago.

= Over — Define a imagem, som e/ou 0s eventos associados ao botdo, caso o
ponteiro do mouse seja colocado sobre ele.

= Down — Define a imagem, som e/ou 0s eventos associados ao botéo, caso ele
seja acionado por um cligue do mouse.

= Hit — Define a area que respondera aos movimentos e cliques do mouse. O

contetdo dessa area fica invisivel no filme. Normalmente utiliza-se uma imagem

em preto para definir a area do mouse.
Iremos criar agora um botdo simples, com o uso de efeitos do degradé da
paleta de cores.

* Na area de edicdo do botdo, faca um circulo dentro de outro, selecione a
ferramenta de Lata de Tinta, selecione a cor de degradé e clique na borda
superior mais a esquerda de cada circulo.

= Adicione um keyframe na caixa Over e mantenha o mesmo desenho do
quadro anterior.

= No quadro Down insira um keyframe. Com a ferramenta de lata de tinta,
selecione 0 mesmo degradé utilizado anteriormente. Clique na parte inferior
mais a direita, somente do circulo de dentro.

= Adicione mais um keyframe no quadro hit, selecione todo o desenho e com a
lata de tinta pinte-o de preto.

Abaixo a ilustracdo de como devem ficar os botdes Up/Over, Down e Hit,

respectivamente:

Para visualizar a animagdo do botdo criado, cologue-o no e pressione
Ctrl+Enter.
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Posteriormente, discutiremos como incrementar agdes aos botodes.
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macro a i
......... : CAPITULO V
ASH CAMADAS

letdtee

Como ja vimos anteriormente, as camadas funcionam como se fossem folhas
muito finas de plastico transparente, dispostas umas sobre as outras. Cada simbolo
ou animagédo deve ocupar uma camada independente nos filmes do Flash, para
facilitar as alteracgoes.

Ao iniciar um filme no Flash, ha apenas uma camada e um unico quadro.
Vocé podera criar tantas camadas quantas quiser ou precisar para melhor organizar
seu projeto. O que vocé desenhar ou editar em uma camada nao afetara os
elementos das demais camadas.

A ordem das camadas no filme define que objetos aparecem em primeiro
plano, em segundo, e assim por diante, até a Ultima camada. Dependendo da
necessidade em cada projeto, vocé podera alterar essa ordem.

Use as camadas independentes também para colocar os arquivos de som e
as acles. Organizando seus filmes desta maneira, vocé facilitara futuras
modificacdes ou ampliagdes nos filmes, pois sera mais facil entender as estruturas e
localizar todos os elementos que se deseja alterar.

Sempre que vocé criar uma nova camada, ela aparecera por cima da camada
gue estiver ativa ou selecionada no momento, e passara a ser ativa. Para selecionar
uma camada, basta clicar em um elemento dela, em algum quadro da linha do
tempo ou na area de identificacdo e controle. Sempre que vocé desenhar ou fizer
alteracOes na tela, essas alteracdes serao feitas na camada q estiver selecionada no
momento.

Inicie um novo projeto. Crie trés simbolos graficos: um circulo preto, um
triangulo vermelho e um quadrado azul.

Coloque o circulo no palco. Feito isso, selecione-o e acione o painel de
Instancias. No painel Effect selecione a opcdo Alpha (transparéncia) e atribua o
valor de 25% para ela. Faca um tweening de 20 quadros, de modo que seu circulo
se desloque da esquerda para direita no palco.

Vamos agora criar uma nova camada. Va até o menu Insert e selecione a
opcao Layer,ou cligue no botdo Add Layer. A nova camada surgira acima da
camada anterior. Repare que o Flash nomeia as camadas como Layer 1, Layer 2,
Layer 3, etc., a medida que vao sendo criadas. Para facilitar a organizacao,
principalmente em filmes com muitas camadas, o Flash permite que vocé altere
esses nomes. Basta clicar rapidamente duas vezes sobre o nome para edita-lo.
Vamos chamar a primeira camada de “Circulo”. Nomeie a segunda camada como
“Triangulo”.
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Insira o triangulo na parte inferior central e faca um tweening fazendo com q
ele se desloque até a parte superior do palco.

Crie agora uma terceira camada e nomeie para “Quadrado”. Insira 0 quadrado
no lado direito do palco. Faca um tweening para deslocar o quadrado até o lado
direito do palco. Abaixo a posig¢éao inicial dos simbolos.

L
i

Executando a animacao, fica clara a sobreposicdo das camadas. Vamos entéao
trocar a ordem em que elas sdo apresentadas. Clique sobre o nome da camada
“Circulo”, arraste para cima e solte em cima da camada superior. Repare que agora
o circulo ficou por cima dos demais simbolos, e seu efeito de transparéncia ficou
visivel. Abaixo a ilustragdo de como estava a animagéo antes e depois da alteragéo
na ordem das camadas:

Para excluir uma camada , basta selecionar a camada a ser excluida e clicar
no botdo Delete Layer, na barra do canto inferior esquerdo da linha do tempo (o
icone da lata de lixo). Se preferir, podera também arrastar a camada até o icone da
lata de lixo, e ela ser& excluida da linha do tempo.
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macro a i
CAPITULO VI
1SH CENAS

let it

Ao iniciar um novo projeto no Flash, ha apenas uma cena. Cada cena tem sua
prépria linha do tempo independente, como se fosse um filme separado, e todos
compartilham a mesma biblioteca do filme.

Esse tipo de estrutura permite a organizacdo do filme em partes légicas, tais
como: introdugéo, aviso de carregamento do filme (para Web sites em que a
transferéncia do arquivo pode demorar um pouco), uma introdu¢cdo com som e
movimento, interface com botdes, finalizagéo e créditos.

Para criar uma cena, va até o menu Insert e selecione a op¢do Scene. Além
disso, indo no menu Modify e selecionando Scene abre-se uma caixa de dialogo,
Scene Properties, que serve para editar o0 nome de uma cena, acrescentar ou
deletar cenas e modificar sua ordem no filme principal.

5 Scenei (ﬂ

& Soere » Duplica uma Cena

Lag Adirinna 11ma Cana

I3 + |G Deleta uma Cena

A exemplo das camadas, para trocar a ordem das cenas, basta clicar no
nome da cena e arrastar até a posicao desejada.

Além da ordem definida na caixa de didlogo, as cenas podem ser
apresentadas a partir de comandos, ou agles, disparadas por botbes ou outros
elementos dentro do filme, dependentes ou ndo da escolha do usuario. Geralmente,
ao pressionar um botdo em um filme em Flash, o usuéario estd desviando a
sequUéncia do processamento para uma outra cena.

Enquanto se esta criando as cenas, uma outra maneira de se alternar entre
elas é clicando no botdo que fica no canto superior direito do palco.

5 e 9

[ =gl % 4 s 4 & 4 W @ & & &l

S L L . R ————
v

[] -3 alli PR o | o
= ‘

| Com esse botdo vocé alterna entre as
cenas do seu projeto, que
convenientemente, chamamos de

filme. Ao lado existe um botédo para
altarnar antre ac ianelac Ae adirin dne

M j o
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. macro a CAPiTL)LO VIl
............ ’ - SH ACOES

bt dtee

As acdes no Flash sdo comandos ou grupos de comandos disparados por
algum evento do filme. Esses eventos podem ser uma tecla pressionada no teclado,
um clique ou movimento do mouse, ou podem estar ligados a algum quadro da linha
do tempo; quando o ponteiro atinge esse quadro, os comandos a ele associados sao
disparados. S&o essas acgdes que criam interatividade nos filmes em Flash, pois
permitem a intervencdo do usuario na sequéncia de execucdo de quadros, Movie
Clips e cenas.

7.1 — ACOES QUADRO A QUADRO

Vamos comecar o estudo de agbes com um exemplo bem simples.

Desenhe barco no primeiro quadro. Feito isso, utilize a ferramenta de Seta
para selecionar o desenho e o converta para um simbolo Grafico (menu Insert >
Convert to Symbol ou a tecla de atalho F8).

Crie um tween de 60 quadros, fazendo com que o barco atravesse da
extremidade esquerda até a extremidade direita, acabando a animacgdo fora do
palco, como mostra a figura abaixo.

Porque colocamos o simbolo fora do palco? Ao

r;'.-.;_::_:m' " ser executado fora do ambiente de desenvolvimento, o
+ || Frawe dcioes + « | simbolo permanece visivel somente enquanto estiver
[ B ambers = dentro do palco. Ao deslocar-se para fora do palco, o
:;J -::::;. . desenho oculta-se na margem direita.

- stlatt = Vocé reparou também que o filme fica se
o sk saiad repetindo indefinidamente, e n&o queremos isto.
PSR Queremos que o filme seja executado somente uma

vez. Para isso, vamos inserir uma acado que
interrompera a execugao no ultimo quadro do filme.

V& até o menu Insert e selecione Layer para
criar uma nova camada. O Flash criard uma camada

¥ o

38
a Centro de Informética — Secdo de Projetos Cientificos
Apostila de Flash 5 Basico www.ufpel.tche.br/ci/spc



UNIVERSIDADE FEDERAL DE PELOTAS

de 60 quadros, e a colocard acima da atual. Aproveite para nomear as camadas.
Nomeie a camada superior como “Agdes”.

Com a camada Ag0es selecionada, clique com o bot&o direito no quadro 60 e
selecione Insert Keyframe, ou pressione F6, para criar um keyframe. Ainda com a
camada de agOes selecionada, abra o painel de A¢des.

Cligue na opc¢éo Basic Actions e selecione a opcao Stop.

Vocé acaba de inserir uma agéo no ultimo quadro da animacgéo. A acao Stop
interrompe a execuc¢do da cena.Esta é uma das a¢Bes mais simples que vocé mais
utilizara no Flash.

Note que, no quadro em que foi inserida a animacéo, aparece a indicacao de
uma pequena letra “a” na linha do tempo. Isto indica que existe uma acéo neste
guadro.

7.2 - ACOES EM BOTOES

Este é um dos tipos de acdo que vocé mais utilizara em seus projetos no
Flash. Anteriormente, vocé criou um botdo simples, que reagia aos movimentos e
cligues do mouse, mas que ndo produzia qualquer efeito além disso. Para que esses
botdes produzam algum efeito no Flash, € preciso que disparem acdes. Vamos
agora criar botdes para controlar a apresentagéo de cenas.

1. Va4 no menu Insert > New Symbol e crie um botdo chamado “barco”.
Na janela de edigcdo desenhe um botéo de forma que se assemelhe ao
mostrado na figura abaixo.

(barco)

2. Na janela de edicdo do bot&o, posicione o ponteiro da linha do tempo
no quadro Over e pinte a palavra “barco” de vermelho. Agora posicione
0 ponteiro no quadro Hit, selecione todo o simbolo e pinte de preto.

3. Construa um novo botdo, com as
mesmas propriedades do descrito
acima, s6 quem com a palavra “carro”
no seu interior.

4. Insira os dois botdes no palco. n 5 (carro)
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Abra o menu Modify e selecione Scene. Renomeie a cena atual de
“Scene 1" para “Botbes”.

Selecione o quadro 1 da atual cena e abra o painel de Agdes. Clique
em Basic Actions e selecione a opgéo Stop.

Vamos criar mais duas cenas. Para isso utilize o menu Insert e a
opcdo Scene. Feito isso, vA no meu Modify e selecione Scene.
Nomeie as cenas para “Barco” e “Carro” e fagca com que a cena
“Botbes” seja a primeira da lista.

Agora iremos trabalhar com as cenas que acabamos de criar.
Selecione a cena “Barco” e crie um tween, de 60 quadros, fazendo com
gue um barco atravesse a tela da esquerda para direita (como ja foi
feito em exemplos anteriores). Crie uma nova camada, denominada
“Acbes”. Com a camada “Ac¢Oes” selecionada, crie um keyframe no
quadro 60 da linha do tempo. Abra o painel de Acdes, va em Basic
Actions e selecione a opcdo Go To. No campo Scene digite a palavra
Botbes. No campo Type conserve a opg¢ado Frame Number e no
campo Frame o valor deve ser 1. Certifique-se que a opgdo Go To and
Play esteja marcada

Cena para onde o bot&o estara direcionando Aqui vocé define

que tipo de

Frame &ctions pal'é.m etro eSté.
siPovie Explorer| (5] Frame .ﬁ.ctinnsl ? Usando, neste
e = e caso € numero
JJ| rame Sguons dO quadro da
E] Easic Actions - animagao_ Pode
@ GoTo ser também,
@ Flay it entre outras
|Line 1: gotetndPlay ['Boties", 1]; opcbes, a cena
— seguinte, a

Scene: IEh:\tu:-es .
anterior ou uma

Tupe: IFrame Turmber eXpreSSéO

Erame: |1
|7 Go ko land Play

& oa

v

Numero do quadro (posi¢do do ponteiro da
linha do tempo) da cena para onde o botéo
esta direcionando.

9. Repita a operacdo na cena "Carro”, s6 que seu tween fard com que um

carro atravesse a tela.
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10. Volte para a cena “Botdes”. Selecione o botédo “barco” e abra o painel
de Acdes. Clique em Basic Actions e selecione a opcado Go To. No
campo Scene digite Barco. No campo Type conserve a o0pgao
Frame Number e no campo Frame o valor deve ser 1. Certifique-se
que a opcao Go To and Play esteja marcada. Repita 0 mesmo
procedimento com o bot&do “carro”, s6 que atribua o valor Carro para o
campo Scene.

11. Com o auxilio da ferramenta Seta selecione e copie os dois botdes.

12. V4 para a cena “Barco”’. Crie uma nova camada e nomeie para
“Botbes”. Com a camada selecionada, va ao menu Edit e selecione
Paste in Place, ou use a tecla de atalho Ctrl+Shift+V. Repita o
processo na cena “Carro”.

13. Utilize o menu Control > Test Movie (ou Ctrl+Enter) para testar sua
animacao.

7.3 - ACOES COM MOVIE CLIPS

Ha um grande numero de a¢Bes que somente funcionam com Movie Clips,
mesmo algumas bastante simples. Isto ndo chega a ser um problema, pois basta
transformarmos em Movie Clip o simbolo no qual desejamos aplicar a agdo, mesmo
gue o simbolo seja uma imagem estatica com apenas um quadro. Para demonstrar
isso iremos utilizar uma dessas acoes, Set Property, que muda certas propriedades
dos simbolos. Trabalharemos com a propriedade Visibility que define a visibilidade
de um simbolo.

Vamos voltar ao filme do carro e do barco. Incluiremos mais dois botdes que
irdo controlar a propriedade de visibilidade dos simbolos.

1. Com o projeto aberto, acrescente dois novos botdes (menu Insert e

escolha New Symbol, ou Ctrl+F8), no formato de circulos, sendo um
verde e outro vermelho.
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2. V& para a cena “Barco” e selecione somente o desenho do barco. Abra
0 painel de Instdncias. No menu [P
Behavior selecione a opgdo Movie Clip  [@ Jrzance|s JEwm 2 Fral o 520
e no campo Name digite FiguraBarco.

e
B Barca

3. Selecione a camada “Botdes” e insira os  Behavier: |Movie Cip =
dois botbes recém criados. De forma
que o resulta se assemelhe ao da figura
abaixo.

Mame: |FiguraBarco

4. Com a ferramenta Seta, selecione o botdo vermelho e abra o painel de
Acdes. Abra o menu
de Actions e selecione |[E=xavis Explarer] 51 Objest Actions)|
a opcgao setProperty. | . T
Dé um Clique no ﬂJl Dbject Actions ﬂ_|
campo de texto ao lado
da opgdo Property e i eerbrepeny i <}|| _'lll

D -
no menu flutuante que @ stantDrag
se abrird selecione a | Line2 setProperty [“FigusBarco', _visible, "0

@ set variable - on (releaze) [

opgéao _visible Eroperty: | _visible [¥isibility)

(V|S|b|||ty) Targst: IFiguraBarcc\

No campo Target yaluz: [0

digite exatamente o

que foi digitado no &

campo Name do painel
de Insténcias (passo 2). Para o campo Value digite o valor 0.

5. Repita o que foi feito anteriormente, s6 que dessa vez com o botdo verde.
A Unica alteracdo deve ser feita no campo Value, que desta vez deve ter
valor 1.
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6. V4 para a cena “Carro” e repita todo processo desde o passo 2.
Lembrando que no painel de Instancias, no menu Behavior, o campo
Name deve ser preenchido com FiguraCarro.

7. Feito tudo isso, execute seu filme e veja que ao clicar no botdo vermelho o
barco, ou o carro, se tornam invisiveis, e tornam-se novamente visiveis
guando o botado verde é acionado.
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magl?l a CAPITULO VIII
/ SOM NO FLASH

Ot dtee

Qualquer interface ou animacdo em Flash ganha uma nova dimenséao quando
uma trilha sonora ou efeitos sonoros nos eventos do mouse e menus. Ha varias
maneiras de utilizar som no Flash. Os sons podem ser executados continuamente,
independentes da linha do tempo, podem ser associados a eventos de botbes, ou
sincronizados com a animacéao.

O tamanho final do arquivo em Flash, com som
dependerd da qualidade de som utilizada e da duracdo do ,
trecho do som. Quanto mais alto o nivel da qualidade, maior Al
serd 0 arquivo, 0 mesmo acontecendo, obviamente, com
sons de maior duracao.

Para inserir sons em filmes no Flash é conveniente
criar uma camada exclusivamente para eles. Se for utilizado
mais de um som, devera ser criada uma camada para cada |Mame
som. Sons de camadas diferentes se sobrepde. & achuvaway

A primeira coisa que se deve fazer para inserir SOM | g Can't stop loving vou..
em um filme do Flash é importar o arquivo. ' '

Libramy - Moviel
2 itemns | Optiong 4

b ew (ORI

1. Prepare um arquivo de audio (.wav ou .mp3, por
exemplo).

2. V& ao menu File e selecione a opgdo Import. H@6 Tl ﬂJ

3. Encontre o arquivo no seu disco rigido e clique em abrir.

Uma vez importado, o arquivo de som ficar4 armazenado na biblioteca.

Para iniciarmos o estudo de sons no Flash, insira um keyframe no primeiro
keyframe da linha do tempo.

Abra o painel de Insténcias e
selecione o painel Sound.

E; aLIf |:|

|[E':Iln5t{i':lEfFeTE|;| FrarTEiﬂESnundi@[l Clique no menu suspenso

- Sound e selecione um som (se néo
Sound: | Can't stop loving you.mps *rI

houver som algum, vocé devera

44 kHz Steren 16 Bit 244.2 = 3308.0 kB @r,n]I?QFIar I{dearquiVO_ de Som) , COMO
ja foi explicado anteriormente).
Effect: | Custom ;l Edit... | Em Effect sdo dispostos uma
série de efeitos sonoros, geralmente
Syne: | Event ;I relacionados a saida de som, com o

som ir de uma caixa para outra,

Loops: |0
somente em uma delas, etc.
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A caixa Sync disponibiliza as op¢des de sincronizacdo. As opc¢des sao:

= Event — Associa a apresentacdo a ocorréncia de algum evento. Sons
associados a eventos sao reproduzidos quando um keyframe é
apresentado. O som é reproduzido do inicio ao fim, independente da linha
do tempo.

» Start — Funciona como Event, com a diferenca de que se 0 som ja estiver
sendo reproduzido, sera iniciada uma nova seqiéncia do mesmo som,
sobrepondo o outro.

= Stop — Interrompe a reprodug&o do som.

= Stream — Ao contrario do som de evento, nesse tipo de sincronizagado o
Flash forga a velocidade da animacdo de acordo com o fluxo de som. Se
nado for possivel apresentar o conteudo grafico com a velocidade
necessaria, alguns quadros poderdo ser ignorados para que seja possivel
acompanhar o fluxo de som. Esse tipo de sincronismo esta diretamente
ligado a linha do tempo, e o som sera reproduzido somente durante o
percurso do ponteiro pelos quadros que ocupa.

Em Loops digite o nimero de vezes que o som devera ser reproduzido. Se
quiser que 0 som se repita indefinidamente, digite um valor bastante alto.

Clicando na caixa Edit, aparecera o grafico do som, com o auxilio das alcas
de edicao é possivel alterar o volume.

LI |
o} & =] 5 Hela |
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8.1 — ASSOCIANDO SONS A KEYFRAMES E MOVIE CLIPS

E extremamente facil associar um determinado efeito sonoro a um keyframe.
ApOs criar uma camada para 0 som, selecione o keyframe em que o som devera ser
iniciado. Feito isso, arraste um som da biblioteca e coloque-o no quadro atual. O
procedimento € basicamente 0 mesmo quando for desejado inserir um arquivo de
som em um movie clip.

Para exemplificar melhor uma das utilizagbes de som no Flash, vamos
descrever uma pequena animacao e inserir trechos de sons.

1.

2.

Crie uma animagéao simples de uma bola quicando duas vezes no chao

Crie 30 ou 35 quadros, crie o desenho da bola no primeiro quadro e
transforme-a em um simbolo Gréfico.

Crie um keyframe no ultimo
quadro e desloque a bola
até a extremidade oposta da
tela.

Crie uma guia de percurso
para fazer a bola quicar
duas vezes no chéo.

Crie uma camada para o
som

Desloque o ponteiro da linha do tempo com o0 mouse, observe o
movimento da bola e descubra em quais quadros a bola estd no ponto
mais baixo da linha, ou seja, em que quadros a bola toca o chéo.
Selecione cada um desses quadros e crie um keyframe no local.

Selecione o primeiro desses keyframes.

Va4 até o menu Window, depois Common Libraries e finalmente
selecione Sounds. Trata-se da biblioteca de sons que acompanha o
Flash 5. Na falta de um som melhor para a bola, selecione 0 som Smack e
arraste-o para o palco. Selecione o segundo keyframe e arraste outra
instancia do som. Execute sua animacdo e veja o resultado. Veja no

=40 s © © @ ® W
[ CamadadeSom = = [J p— p_
v Guiade Percurzo « + [O)s 0
8.2 — ' EBola 4 .
[+) [ & || 4] &lal Bl L 1 [rzons [ oos 4] |
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ASSOCIANDO SONS A BOTOES

Agora veremos como associar sons a botdes. Para isso crie um botdo com
algum tipo de efeito em seu quadro Over e outro no seu quadro Down. Feito isso,
faca o seguinte:

1.

No modo de edic¢do, crie uma camada para sons na linha do tempo do
bot&o.

Crie um keyframe no quadro Over.

V& ao menu Window, depois Common Libraries e selecione Sounds
para ter acesso aos sons que acompanham o Flash 5.

Escolha um som que considere de acordo e arraste para o palco. Esse
som serd associado ao evento Over do botao.

Agora, crie um keyframe no quadro Down e arraste outro som diferente.

é{ Scenel1 g botdo

- Y D||_Uﬂ Over[Dowr Hit |
[ Botio = e W L)Ll sl |
% & & ||t Blo| Bl Ll v [1z0ms [ oos 4]

8.3 — COMO CRIAR UMA TRILHA SONORA

Para exemplificar a criagdo de uma trilha sonora, vamos carregar o filme que
utiliza a cena do barco e do carro. Como ndo ha arquivos musicais no Flash, vocé
devera importar um arquivo contendo algum trecho de mdsica. Para obter um

arquivo de tamanho reduzido, importe um arquivo mp3 relativamente pequeno.

1.

Importe o arquivo no filme.
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2. Na cena principal, em gue se encontram os botdes, crie uma camada e

nomeie como Som.

3. Selecione o primeiro e Unico quadro da camada.

4. Abra a biblioteca e arraste uma instancia do som para o palco.

S ound x|
[E '.—_|»In5t{i.'!—"t EI:I:E'T el Frar{E‘iE Sound @

Sound: | thatzpot ;l
44 kHz Sterec 16 Bit 14.5 5 2629 kB

Effest: | haone | Edi. |
Sync: I Skart ;I
LDDpS:IEUUU

5. Abra o Painel de Instancias e
selecione o Painel Sound.

6. No menu suspenso Sync,
selecione a opcgédo Start. No
campo Loops, digite um valor
bastante alto para que o loop
seja infinito. Em nosso exemplo
utilizamos 5000.
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macro
1SH

Ot dtee

Ao longo dessa apostila, aprendemos a elaborar animagdes e seus controles,
nos resta publicar e visualizar o resultado. Sua animagéo pode ser exportada em
diversos formatos. O padrdo para animacdes Flash é a exportacdo para o Flash
Player e Flash Plug-in, nos quais a animagédo é compilada e recebe a extensao

a

CAPITULO IX
PUBLICANDO ARQUIVOS

s

.SWF e esta pronta para ser distribuida ou inserida em uma pagina HTML.

Para publicar seu filme, clique no menu File e selecione Publish Setings

(Arquivo, Configurar Publicacdo) e escolha o formato desejado.

Publizh Settings

Formnats |

Type:
[™ Flazh [ swi)

= | Generaten Template [swt

[~ HTML [html)

[ JPEG Image [jpg]
™ PMG Image [.png]
[ Windows Projector [.exe]

[ Macintosh Projectar
[T QuickTime [.mov]
[ RealFlayer

(]
Publizh
Filenarne:
Cancelar
IMDWEE.SWF
|M|:uwe2.swt

IMW.Eg_hw |1 Com Use defaults names

arquivos

_ marcados  0S
IMDVlEE.gl.‘ ~
gerados terdo 0 mesmo
[Movie2 jpg nome da animacdo (.fla).
IMwiez,png Caso for desmarcada essa

— opcao e possivel a
atribuicado de  qualquer
[Movie2 has nome aos arquivos
Movie mov gerados.
MovieZ zmil
W Use default names
Ajuda

Apoés selecionar o formato dos arquivos desejados, clique em Publish. Os

arquivos serdo gerados no diretério em que a animagao estiver salva.

Ao selecionar uma opcgao cria-se uma orelha para uma nova janela, em que

pode-se editar as op¢des de acordo com o formato de arquivo selecionado.

50

$A

Centro de Informéatica — Secado de Projetos Cientificos
Apostila de Flash 5 Basico www.ufpel.tche.br/ci/spc




# UNIVERSIDADE FEDERAL DE PELOTAS

Abaixo uma janela de edi¢cdo quando selecionada a opcéo JPEG.

Publizh Settings

Lembrando que quanto maior a
qualidade atribuida, maior sera o
tamanho final do arquivo.
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CAPITULO X
=5, macrom@®a  LAYOUT DE UM WEB SITE
ASH BASICO

Ot dtee

O projeto descrito em seguida é bastante simples, mas define as bases para a
construcao de projetos mais complexos e envolventes. A diferenga entre um site de
impacto feito em Flash e um site com resultados pobres estd mais ligada a dons
artisticos do seu criador do que ao lado técnico de sua constru¢do. A combinagéo
adequada de imagens, animacdo e trilha sonora é que define o sucesso ou o
fracasso de um site em Flash — ou em qualquer outra tecnologia.

N&o ha uma ordem certa ou errada de iniciar um projeto. Ha, provavelmente,
tantas ordens possiveis de iniciar o desenvolvimento de uma interface quanto ha
desenvolvedores.

Uma boa maneira para iniciarmos o projeto é definindo as propriedades do
arquivo que iremos produzir. Para isso va até o menu Modify e selecione a opgéo
Movie. Feito isso, se abrird a caixa de dialogo Movie Properties.

wie Properties Dimensodes do filme

N° de quadros g |
Frame Rate: |‘|2 fps (] 4 |

apresentados
or segundo
por seg Width Height
Dirnensions |55|:| pi 5 |4IZID p
Cor de fundo _ E
aplicada ao filme Match _Binter | _Conterts

Backaround Caolar: J \

Unidades de < Buler Units: IF'i:-:els Help |

medida para
as réguas v <

Tamanho final
do fiime se

ajusta para a
imnrescan

Ajusta o tamanho do
filme ao conteudo
do palco

Observacédo: No quadro Frame Rate, para apresentacdes na Web o valor deve ficar
entre 8 e 12 fps , sendo o ideal 12 fps.*

Uma vez definida a area de trabalho e os parametros gerais do filme, crie as
camadas que serdo utilizadas. E interessante que se tenha uma camada para cada
tipo de aplicagédo que for ser utilizada em seu projeto. Em nosso site teremos as
seguintes camadas: fundo 1, fundo 2, texto, trilha sonora, botdes e acdes.
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i E importante lembrar que as

- D camadas estdo dispostas uma

o sobre as outras. Sendo assim, as
— camadas “Fundo 1” e “Fundo 27,
i} Botdes + =+ [] que, como 0 proprio nome diz,
; conterdo o plano de fundo de

L/ Tiilha Sonara « + B nosso site, devera ficar abaixo de
L__D; Texto e D todas as outras. Outra camada
observada é a “Botdes”, que deve

[? Fundo 2 « + [] ficar acima da camada “Trilha
Sonora”. Assim, 0s sons emitidos

! Fundo 1 + + W pelos botdes irdo sobrepor a trilha

sonora.

Selecione a camada “Fundo 1”. Iremos acrescentar um tween de 20
frames, fazendo com que a palavra “FLASH” apareca no centro da tela, um pouco
acima, com uma fonte relativamente grande. No ultimo frame da animacéo a palavra
deve diminuir de tamanho e se localizar no canto superior esquerdo da tela.

FLASH
FLASH

Vamos agora para o “Fundo 2”. Depois de se certificar que é essa a camada
selecionada, crie também no primeiro frame um tween de 20 frames. No primeiro
guadro da animacao insira o algarismo “5” logo abaixo a palavra “FLASH” (lembre-se
gue a palavra estd em outra camada!), com um tamanho proporcional a ela. No
tltimo quadro do tween faca com que o algarismo figue de um tamanho que ocupe
praticamente toda tela. Com o auxilio da ferramenta seta, deixe-o em diagonal, e
para melhorar a visualizagdo do site aplique um efeito de alfa (transparéncia).

FLASH
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Partindo para a camada “Texto”! No 20° quadro insira um keyframe (é o
guadro em que as animacdes ja estardo concluidas). Digite seu nome, depois com 0
auxilio da seta deixe na vertical e coloque-o no canto direito da tela. Na parte
superior da tela também cologue o seguinte: “Apostila de Flash 5 Basico” e
“Capitulo X”. Observe na figura abaixo o resultado final:

=
| N
@
©
o
=
Le.
=
(¥
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Comecamos a parte musical de nosso projeto, iremos trabalhar agora com a
camada “Trilha Sonora”. Crie um keyframe no primeiro quadro da camada. Apés
importe um arquivo sonoro e arraste para o palco. Selecione o keyframe onde esta
inserido 0 som e abra o painel Sound, localizado no painel de Instancias. Na caixa
Sync selecione Start, e na caixa Loop digite um valor bastante alto, para que seu
som se repita indefinidamente.

é Scene 1
&= 5Ol
[ tcies + « [
[ Botdes . s [] |
B Tiiha Sonora : ?
[ Texto + o+ [ |. SDund:Idance ;I
[ Fundo 2 + o+ [0 22 kHz Mona 16 Eit 2.7 s 117.8kE
J L]
D o) TR ET Fe : = Edit... I -
[+ %) @ || 4] wlwl Bl B[ 1 [120ms | o Effect: | Mane | =
Sgnc:IStart ;I =
Library - site LDDps:I 10000
[ 2 itemns [ Dptiuné_
1KY
Mame = |
g5 dance |
{
Tween 1 —-
E' Tween 2 =
HEe @A | | 3

Proximo passo: botées. Qualquer duvida referente a criagdo dos mesmos
consulte o Capitulo IV — Simbolos. Precisaremos de trés botbes: um para
apresentar suas informacgfes pessoais, um para e-mail e outro que ird parar a trilha
sonora.

Comecaremos por esse Ultimo, crie um movie intitulado “Botdo de Som” e
abra sua janela de edicdo. Como mostra o desenho abaixo, faca a animacdo de
modo com que o alto-falante emita pequenas ondas sonoras. No menu Control
marqgue a op¢ao Loop Playback.
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..... Crie um botéo, chamado “Botdo de Som”. Com o ponteiro no quadro Up arraste o
movie criado anteriormente para o palco. Crie keyframes nos demais quadros da
animacgéao..Na opc¢éo Hit desenhe um quadrado em torno do movie, de modo que o
enquadre totalmente. Vencida esta etapa, arraste o botéo para o palco, colocando-o
perto do canto superior direto. Ajuste o tamanho de sua instancia para que fique
proporcional ao tamanho de seu filme. O resultado deve se parecer com o ilustrado
abaixo:

FLASH

APOSTILA DE

CaPITULO X

Fulano de Tal

E hora de definir a acéo
ect Actions desse botdo, apds seleciona-lo no

“yMovie Explarer| 5 Object Actions] 2] palco abra o painel Object Actions.

+| = || Obiest Actions Em Basic Actions, selecione a opcéo
@ ooto — Stop All Sounds. Desta forma a trilha
@ Play sonora sera interrompida.
@ Stop : ¢ :
@ Toggle High Cluality § items Options
£ Stop Al Sounds nn

&

Nosso botdo esta pronto pra entrar em acao, mas
antes de seguirmos em frente vamos a uma dica importante.
E importante termos nossa biblioteca organizada, e para [Hame 2
iSso é interessante agruparmos em pastas elementos do (] Botio des.:m-arquw%

filme que estejam de certa forma relacionados. Abra o painel : [ Botdo de Som
Library (Biblioteca) e crie uma pasta chamada “Botdo de ¢ 50

Som — Arquivos”, arraste para li 0 seu movie e 0 seu botéo i@ sons

recém criados. Crie uma pasta “Sons” e coloque ali o
arquivo usado na sua trilha sonora, mais tarde qualquer @ Tweens

arquivo desse tipo também sera armazenado ali. Vocé deve _|;|
ter observado que existem arquivos na sua bibliotecacomo H#6 mHA|| »
nome de Tween. Eles s&o as instancias da animagéo usada em seu filme principal.
56
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Crie uma pasta “Tweens” e arraste esses elementos para este local. Veja como a
biblioteca melhora muito o seu aspecto depois de realizado esse processo.

Véa até o menu Modify e selecione Scene. Ira surgir uma caixa de didlogo
contendo a uUnica cena do filme. Com um clique duplo sobre ela renomeie para
“Principal”.

Partimos entdo para nosso segundo botdo, que nés levardA a uma cena
contendo nossas informacdes pessoais. Nomeie o novo botdo para “Informagdes
Pessoais” e va para sua janela de edicdo. Faca um desenho semelhante ao
mostrado a seguir. Crie keyframes nos demais quadros do botdo. No quadro Over
pinte o “bonequinho” e a frase abaixo de outra cor, e no quadro Hit faca um
guadrado em torno da frase abaixo do desenho, para facilitar area a ser clicada.
P  Ainda na janela de edicao

do botéo, crie uma nova
ﬁ ﬁ camada chamada “Som”.
R A Crie um keyframe no

[ W  uadro Over e arraste um
arquivo sonoro de sua
preferéncia da biblioteca informacg Ses pessoadis

do Flash para o palco da janela de edicdo (Window >

Common Libraries > Sounds). Feito isso armazene o arquivo escolhido dentro da

pasta “Sons” de sua biblioteca. Agora que o botédo esta pronto é hora de transporta-
lo para o palco principal, colocando-o préximo da extremidade inferior esquerda.

Selecione e abra o painel
Object Actions. Na caixa
Scene digite “Inf Pessoais”, em
Type selecione Frame
Number, para a caixa Frame
atribua o valor 1 e marque a
caixa Go to and Play.

o
T

Iz [1zops

| Line 2: gotodndPlay ["Inf Pessoais”, 1); Traduzindo: esse botéo_levaré
r— ~ . — para a cena’ Inf Pessoais, em,
- Botdo Duplicate | | seu frame numero e executara
Tupe: |Frame Mumber W as animag(‘)es a partir desse
Erame: |1 frame.

|7 Goto and Play

& o Precisamos entédo criar a
cena Inf Pessoais, para isso va
novamente até menu Modify e
selecione Scene, selecione a
Unica cena do filme. Apods clique
no primeiro botdo do rodapé da
janela, Duplicate, e obteremos
uma copia da cena Principal.

Scenei (Ei

|+ |
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Nomeie a cena duplicada para “Inf Pessoais” e apague a camada que contém
0os botbes.Selecione a camada texto e digite alguns dados pessoais, como no
modelo abaixo:

FLASH

CARITULD X
fulano de tal
assistente administrativo
dept. pessoal
TYIVIRYY
fulanoc@ufpel.tche.br

Fulano de Tal

Agora selecione a camada Acdes. Crie um keyframe no frame 20 e abra o
painel Object Actions. Em Object Actions selecione Stop, assim a sequéncia para
guando alcancar esse frame.

Voltando para a cena principal vamos criar o proximo bot&o, que ird chamar
uma outra home page. Esse novo botdo ir4d se chamar “Home Page”. A seguir o
modelo do novo simbolo:

Use a mesma ldgica das propriedades atribuidas ao
bot&o criado anteriormente.

Depois de colocar o botdo no palco da cena
Principal, ao lado do botdo Informag¢6es Pessoais, vamos
editar sua acado, selecionando-o e abrindo o painel
Object Actions. Em Basic Actions selecione Get URL.
(]

ﬂj| Object Actions b AN

(@ sStop Al Sounds - on

home page

No quadro URL, digite o endereco do
site escolhido. No menu Window selecione
_blank para que a pagina Web seja carregada @ FsCommand
em uma nova janela do navegador. Se preferir [Line 2: getURL [“wwww.uipeltche.br", *_blank");
que a pagina Web substitua o filme atual na
mesma janela, selecione _self. Em Variables
deixe o atual valor Don’t Send. Mindau: | blarik

Mariables: I Con't send

LFRL: Iwww.quel.tche.br
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Mais uma etapa vencida. Vamos ao terceiro e ultimo botdo do filme. Crie e
nomeie esse botdo para “E-Mail”. Novamente siga os padrdes utilizados nos botdes
anteriores. Com o botdo no palco principal vamos editar sua
acdo. Selecione novamente a opgdo Get URL em
Basic Actions. No
campo URL digite

r[ F Object Actions

e - m ail ﬂj| Object Actions - A
@ Stop All Sounds - q

mailto:” fulano@ufpel.tche.br @ GerURL

@ FSCommand - »

3 | Line 2: getURL ["mailto:\" fulano@uipel tche bt ):
Ndo esqueca de colocar o

enderego entre aspas, ou a(;éo nao URL: IrnaiItc\:"Fulann@quel.tche.br"
funcionara. uindow: |

Os botdes ja estdo em seus
devidos lugares e com suas devidas
acbes configuradas. Vamos apenas & -
deixar o site mais estético. Observe a
ilustracdo abaixo e faga algum tracado, na camada Fundo 2, indicando serem
aqueles botdes pertencentes a um menu.

Nariables: I Dion't zend
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Estamos quase no fim. Ainda temos que criar mais uma cena, bastante
simples, que contém um truque que faz com que o filme aguarde o carregamento de
todo o arquivo, antes de comecar a apresentacdo. Isto é bastante conveniente para
filmes transferidos pela Internet, pois evita interrupgdes na apresentacédo do filme.

Para comecar crie uma nova cena (Insert > Scene), com ela ja criada,
nomeie para “Carregamento” (Modify > Scene). Feito esses passos iniciais, crie
duas camadas nessa cena, uma denominada “Movie” e outra “A¢des”. Na camada
movies crie uma pequena animag¢ao no primeiro frame, que indiqgue que o filme
esteja carregando. A palavra “carregando” piscando seria uma boa sugestao.

Véa para a camada “Acbes” e insira a acao que ir4 aguardar com que todo
filme seja carregado antes de passar para a cena seguinte. Em Basic Actions

Frame Actionz

H!Mol.lie Explarer| ] Frame .ﬁ.ctinnﬂl

ﬂj| Frame Actions

@ Tell Target -
@ IFFrame Is Loaded
@ On Mouse Event -

| Lire 1: ifFrameloaded ["Inf Peszoais”, 20) §

Scene: IInF Feszoais

Type: I Frame Mumber

Erame: |2IZI

Deixe marcada a opcéo
Flash e HTML. Depois clique
em Publish. Serdo criados os
arguivos selecionados no
mesmo diretério em que esta
salvo o projeto. Abra o arquivo
HTML e teste o site.

Se tudo ocorreu como
dentro da expectativa,
parabéns. Vocé acaba de
confeccionar um site com todas
as acgbes basicas necessarias
para o funcionamento de uma
boa home page. O préximo
passo é dar asas a imaginacao,
utilizando essa poderosa
ferramenta de criagdo nas suas
mais diversas necessidades.

Publizsh Settings

[T | Gererator Template (fswt] Isite.swt
[V HTML [ html] fsite. bt
I~ GIF Image [.gif) Isite.gif

I~ JPEG Image [jpg) Isite.ipg

[~ PNG Image [.pna) Isite.png
™ ‘windows Projector [ exe) Isite.exe
™ Macintosh Projector Isite.hqx
™ QuickTirme [.mov) Isite.mov

™ BealPlayer [site.smil

selecione If Frame Is Loaded. No campo
Scenes selecione Inf Pessoais, que sera
a Ultima cena de nosso filme. Em Frame
digite 20, que é o ultimo frame da ultima
camada do filme. Para concluir falta
apenas ordenar as cenas, de modo com
gue a cena Carregamento seja a primeira
do filme e a cena Inf Pessoais a Ultima.
Isso pode ser feito utilizando o menu
Modify e selecionando a opgao Scene. Na
caixa que se abrira cligue na cena que
deseja e coloque na ordem desejada.

Salve seu filme, va no menu File e
selecione a opc¢do Publish Settings. Ira
se abrir o seguinte quadro:

Fomats | Flash | HTML | oK

Publish

Filename:

s,

- Cancelar
Isﬂe.swf

W Use default names

Ajuda
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